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1) + = I8
2) - = He|
3) x = dqum
4) + = I
5) % = wfderd
6) v = dUF
7) . = gataT
8) A = gy
9) Q = 3H
10) « = 3ad
11) ™ = 9§
12) w = A
13) ° = 390
14) L = ¥
15) 6 = ler
16) ® = Wi
17) B = drer

18) = = R



19) # = SO TG &
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20)
21) ? = 9T aras
22) a = 37wl
23) || = AR
24) ~ = GEXIE

25) 1 = 3{eqqrd

26) 11 = HARTIT
27) ~ = AR

28) | = thaaiRTe
29) f = Wl
30) @ = e H
31) ; = ST fH
32) / = wfa

33) ( ) = DleTHIseHh
34) { } = FSA FICH
35) [ ] = SsTHISCh
36) > = YT

37) < = ABIe



38) = = A

39) 3 = "IHA

o

40) 1 = dIE

41) = = HaEEA
42) v = gt & forw
43) 3 = IRATHE

44) 3 = ARAA A AL g

45) £ = PIUT
46) y = f@ean
47) ¥ = @18
48) & = 3eal
49) \ = oiFsr

50) = AR Tal &
51) + = HHART Tel &
52) d/dx = 37deheleT

53) N = HHTIL HT FATAYS

54) U = FHTUAN T GIEA

55) iff = had 3R Faa Il

56) € = TEET g!



57) ¢ = AeET el &
58) def = TRHTST
59) p = ¥

60) | = HHR

61) c = 3UEHTAT &
62) = = Hohd AT
63) | | = AU
64) ' = fAsIe

65) " = dhs

4. ST SBIHTFASS—CO,
5. STeT AAFASS—CO
6. TohT SBIHTFATSE—SO0,
7. ATSEIST SBHTFATSE—NO,

8. ATSCIoIA AAFASS (ASfee 3HFarss) — NO

9. STEATSCIST TFAISS (ATSeH HTFarss) — N,O
10. FeilleT — Cl,

11. gI83ISTeT FARTSE—HCI

12. 37T — NH;




3 H
13. gr8giFellReh TfAs — HCl

14. GergRe U5 — H,SO,

15. Arsfeeh Tfls — HNO;

16. BB TR — H;PO,

17. Fr&ffeis Tfg — H,CO;

&R

18. AifsTe grsgraarss—NaOH

19. AT grgsrFarss—KOH

20. hierIH gragraarss—Ca(OH),

CEI

21. AIf3TH FeRIS5—NaCl

22. FEfae AfsTHa—Na,CO;

23. hierIH HrEfeie — CaCOs;

24. HIeRITH Fethe — CaSO,

25. 3ATATH Hothe — (NH,),S0,

26. sTg¢c I fAIA—KNO;

3TH IHIEAT oh SATaAT e U T foleh AT
ST ATH — |IAPUC ATH — 37T X

27. AT — hioTIH Frefaic — CaCO;

28. 319X T A — Te[ehlol — C6H1,06

Ucohlgel — TAel 29. Teehlgel — C,H50H

30. FHIfEce Trerer — UIehATH gregerass — KOH
31. @TeY T ST — AIfSIH T5hlaiac — NaHCO;
32. eIl — HfeaTA 3HFASS — Cal

33. oeaH — FHfeaad Gethe — CaS0,.2H,0
34, . TA.E. — TS ATSEr eTelled — C6H,CH3(NO,);
35. &ilel T AIST — ANf3TH Prafec — Na,CO;

36. el UTIT — FHIOR Tethe — CuSO,

37. AlgreT — 3ANATH FARESS — NH,C

38. ftheandl — dITATH TAATATH Fethe — K,S0,AI,(S0,);.24H,0
39. TSI YoAT — HicHIH gISgrraTss — Ca(OH),




40. #ig — T — CB6H1005

41, ofheT | — A8 H 3TFarss — N,O

42. SITeT GaT — T TATH THIIc — KMnO,

43. ool TlgY — ofs TAHTFASS — Pb;0,

44. sk §th — B HIeA-3T5-3MTFH$S — CO,

45, ART — NEF{IA A5¢e — KNO;

46. o1 — ThAfes TS &1 e bl — CH3COOH
47. G — SRFH — Na,B,07.10H,0

48. f&9e — AfAer Tehlgel — CH;0H

49. ToIe — TATAHT TR 3HTFAES — Al,052Si0,.2H,0
50.837 AT — Hikeh Tethe — Fe,(S0.,)
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- didel
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*$iifaes TTA Physical quantities 31T $ifaes TRAT & Feer
1. 8T%hel Area oi€Ts x TS



2. 3T Volume daTsx ASExFaTS

3. acd AT "elcd Density gedH /3T
4. g Frequency 1/3Tectenrel

5. 33T Velocity Taeamg=1/aaax
6. TTel Speed g/FAT

7. cauT Acceleration 33T/THT

8. d¢cT Force ged AT x cdlU]

9. 31A9T Impulse ol x AT

10. & Work ef x gt

11. 35T Energy &ef x g

12. AfFd Power SHRI/GHIA

13. G33T Momentum GeIHTsT x daT

14. 19 Pressure del/&T Tl

15. gfdeer Stress del/&Twal

16. Tashfcr Strain fa#T & TREcH/#eT faar
17. YeIEAT [0Tish Coefficient of elasticity Tfdsrel/fashfad
18. Jv& d=A1d Surface tension Sel/elels
19. Y56 Fait Surface energy oil/&TTthel

20. 937 99T Velocity gradient 3a1/gdr



21. G YaUTT Pressure gradient &rel/gdl

22. AT a[0Tieh Coefficient of viscosity FoT/(&TTthelx FIT FUTAT)
23. T Angel Tma/B=ar

24. FRUTTAT 34T Trigonometric ratio eTS/caTS

25. ST I Angular velocity STOT/EHT

26. ShIofIT caioT Angular acelleration IO I/THT

27. @IV HA9T Angular momentum STSca 3TEOT x 0TIy a1

28. STScd TEOT Moment of inertia Gea#TsTx (TRFHATT fF=am)2
29. F7T 3TEOT Torque o x g

30. A0fF 3mgfea Angular frequency 21 x 3Tgfed

31. I&cdIg ArdTIeh foadier Universal constant of gravity siefx (gd1)2/(seg#TeT)2
32. efieh feidieh Plank’s constant Fil/3Tg e

33. faferse 3sAT Specific heat 3SR F3T/(GeTHTTx dATY)

34. 3SAT GTRAT Heat capacity FSHIT S/

35. SlecaTATT faadis Boltzmann’s constant Fai1/dra

36. Tt fadie Stefan’s constant (FSiT/&TTHelx THT)/(ATT)4
37. 3T [Aadie Gas constant (g1 3TIdeT)/(HTelx dTq )
38. 3MAeT Charge faegd &RT x THY

39. fIHATAT Potential difference RY/3Taer



40. 9farer Resistance faerareR/faegd amr
41, &TRET Capacity 3TaRI/fasTaraR
42. faegd &7 Electric field degd Sel/3maer

43. TFIHI 817 Magnetic field Sef/(fRege e wies)

44, FFSHIY Felrd Magnetic flux TR &1 x FaTg

45. 9ehcd Inductance TFeehrd Felerd/faegd emT
46. 1T fTdieh Wein’s constant diareed xdrq
47 . TTelehdT Conductivity 1/9TaRTer

48. TETIT Entropy 3SHT Fall / 19

49. I 3SAT Latent heat ISHIT FalT / ST AT

50. A9 9ER 90Tish Coefficient of thermal expansion fa&T & gRecteT / (el fa#AT x a1

nbsp51. 3Tl FeATEAAT a[uTieh Bulk modulus ( 3T x &9 & GRacie )/3ceT #
afRade

52. degd TicRTerehdll Electric resistance ( FTeRIE x &T9thel )/ SaTS
53. degd gfdjd 3guT Electric dipole moment sef 30T / faege &lcX

54. gEhIT Siad ITECT Magnetic dipole moment sef 3TEUT / Tasehl &Y

55. YFEAehTY &1 Felolcll YFaehrg TEOT / 3Tclel
56. 39ddas Refractive index faTd & YarTel T IAT/ATETH H TehTer T drel

57. TR AT Wave number 211 / aRETGE



58. fafertor afed Radiant power 3cafoid 41T / 87T

59. fafesor Figar Radiant intensity fafetor erfard / o<1 sroT
60. &<l fidcTeh Hubble constant 92T HIOT =Tl /&{T
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1. 3TFHTSTT—O0,
2. ATFEISTA—N,
3. gI8aIeled—H,
4. e SBIHFASE—CO,
5. STeeT ATATFASS—CO
6. TohT SBIHTFATSE—SO0,

7. ATSEIST SB3HTFATSE—NO,

8. SATSCISle AAFASS (ATsfeed ’eFarss) — NO
9. SEATSCIST 3TFASS (ATSeH HTFarss) — N,O
10. FeileT — Cl,

11. gI83ISTeT FeRT85—HCI

12. 3TAfAAT — NH;

3o

13. gr8glsellReh Tfis — HCl

14. GergRe TRAs — H,SO,

15. sirgfesh tfAg — HNO;

16. BREHIRE TFAs — HPO,

17. Feifes TS — H,CO;

&R

18. OifsT# grssFass—NaOH

19. 9refATH gr8sTFarss—KOH

20. hTerRIH ISsFaE5—Ca(OH),

ofduT

21. OIfsT#d FeRS5—NaCl

22. Frdfec WsTH—Na,COs




23. erIH @rEfeic — CaCOs;

24. HTIH Fethe — CaSO,

25. 3ATATH Hothe — (NH,),S0,

26. sTg¢c e fAIA—KNO;
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AT ATH — IAPUC T — 3707 IR
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28. 39X T Hl — Te[ehlol — C6H1,06

Uohlgel — TTel 29. Teehlgel — C,H50H

30. SITEeeHh YIerer — Ui gresreass — KOH
31. WTel T AIET — AISTH SShEic — NaHCO;
32. AT — HTCHIA HTFATGS — Ca0

33. foread — FHfeaad Gethe — CaS0,4.2H,0

34. E1.UA.E. — TS ASEI elelled — C6H,CH3(NO,);
35. €Y &7 TS — 3T Fefdc — Na,COs;

36. AlelT UTAT — FHIOX Fethe — CuSO,
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40 §oCT---FRpAT eliam

A1 HFHI---TSIT A

42 THTCT---eATghII Aehe] TEholcH
43 ATRIS---Iehl =BT

44 QY ---Aeld FfAAT/SIATEC T
45 FTRMYTH---ATeH FIfATAH
46.HTR---hing dfefaaa

47 IS[---UeThI TS TH IRTHCHHA
48 ITTSIR---3ThE hleT

49 .37e3p--- TS foeR 3ihfAsrer
50.Poranef---smiaeht Jitferfrar
51. g EeT---UTerIH sl

52 1S a1 T
53.9oRT---9fATHCH 3TAJPIAH
54 ATCI AT ---hCHTH T3
55 . Tl THT---UTSu TSI
S6STGTH---oTH 3RA IR

57 STIdl---3 Tl RAT HISATHA
58 .helT---FgTT RIS aTaT
59.3ell---Xthelql
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Ans : - ST
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14.: - FET FFIT AN FT HETTT FEATdT &

Ans : - oncology
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Ans :

- SogIe]Y # fora ToT &7 faataoT 37fe BT 87
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AnNs :
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28.:

ANsS
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ANS :
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-7
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- ST IT33T & AT TACAT ST aTell TR T 9red giar g
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ANS :
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- df¥eT FifreT
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Ans : - TR
34.: - [T 7 & o5 gerdl & 91 AgT 9TaT ST g2
Ans : - didel

35.: - AT T ATETSH T fohder ITH &7 gIaT &7
Ans : - 1350
36.: - Yol A UIAY SiTed aTell &1 &

Ans : - -IgT

37.: - ATEURIAT # fhd 31Fcl o ThiAd aled T Uhrdc ATdl &7
Ans : - offFca 37T

38.: - fhuae T 3eEI0T &

Ans : - -G8 T TET BIAT,WTel T N5 T SeTall, I T T TET Blel
39.: - YU I fhefil 3T gleir 82

Ans : - Teh 3 8T
40.: - ISR T TaeTf@eT &1 aefg 9 &7
Ans : - [qeTfA A

T WA Physical quantities 3= Hifas Tt & Feer

1. 819l Area o€TS x ST
2. 3T Volume daTsx ASexFa1s

3. acd AT "elcd Density gedHT/3TT
4. 3rgfed Frequency 1/3TTactenrel

5. 39T Velocity [aEama«/ad#g
6. Tel Speed gU/FAT

7. caduT Acceleration 33T/9HIT

8. dcl Force gedHTeT X daiUl

9. 31A9T Impulse el x AT



10. S Work ef x I

11. 31T Energy &ef x JI

12. AfFd Power SHII/GHI

13. IAIT Momentum GeIHTeT x daT

14. 19 Pressure Jel/&T Tl

15. gfaaer Stress Fol/&1ThHdl

16. fashfcr Strain fa#AT 7 aRacr=t/#{er faaT

17. YeIEACT [0Tish Coefficient of elasticity Tfdsel/faspfa

18. Y& deld Surface tension Sel/clels

19. Y& Fait Surface energy Fall/&TTthel

20. 9971 99T Velocity gradient aT/gdr

21. EId YaUTT Pressure gradient &rei/gdl

22. QT [UTish Coefficient of viscosity STe/(87Tthelx JaT FauTAT)
23. T Angel Tma/B=ar

24. RRUTTAT T4 Trigonometric ratio SeTS/caTS

25. ST 33T Angular velocity SHOT/EHT

26. ShIfIT caioT Angular acelleration IO J/THT

27. IO HA9T Angular momentum STScd 3TEUT x sHiofig a1

28. STScd JTEOT Moment of inertia Gea#TsTx (ARFHTT fF=am)2



29. Fef ATEOT Torque ol x g4

30. &IUfT 3gfed Angular frequency 21 x 3iTdfce

31. I&cdIg AT fAadieh Universal constant of gravity siefx (gd1)2/(seg#TeT)2
32. efieh feigdieh Plank’s constant 3T/ e
33. fafdrse 3sAT Specific heat 35T FA1/(gGeTATTx A1)

34. ISAT GTRAT Heat capacity FSHRT Fal/drd

35. SlecolATT fAIdis Boltzmann’s constant Zail/dra

36. TEHeT fATdie Stefan’s constant (FS1/&TT%helx THT)/(ATT)4
37. 3\ Tdi® Gas constant (GTax 3TadeT)/(HTerx dTq )

38. 3T Charge T ORT x AT

39. fa91araR Potential difference sy/3maer

40. 9fcRIEr Resistance feraieR/fdege e

41. a1i@ar Capacity 3maer/fas@arar

42. Tdegd &9 Electric field degd ser/3maer

43. TFIHT 817 Magnetic field Se7/(Reg e URTx wiTs)

44, GFEHIY Felerd Magnetic flux Traehie &1 x FaTg

45. 9hed Inductance YFeehrd Forera/faegd eRT
46. AT TATATH Wein's constant dETEET xdTd

A7. ITelehdT Conductivity 1/9faRrer



48. TETIT Entropy 3SH Fall / 19

49. 9 3AT Latent heat 3SHIT 3l / GeaHTe

50. AT 9ER I[0Tish Coefficient of thermal expansion fa&T & gRacteT / (el fa#T x 1)

nbsp51. 3R JeATEAAT IO Bulk modulus ( 3T x &Td 7 TR )/3ard &
afade

52. degd TfarershdT Electric resistance ( FfRIE x &TFthel )/ FaTS
53. degd gfata 3y Electric dipole moment el 3TET / faege &leX
54. gEehTY gfaera JTEET Magnetic dipole moment S7eT 3TELOT / Feehly &cX

55. TFehTY &1 FeloTcll YFaehd JTEOT / HTclel
56. 379ddele Refractive index faTa & JarTeT hT ITel/ATETH H TehTer HT Aol

57. TR AT Wave number 211 / aRETGE

58. fafeszor afdd Radiant power 3cafoid 41T / §H3
59. faferor dgar Radiant intensity TafeRToT e / €T ShIoT

60. el T3 Hubble constant 9= HOT =Tl /&dY
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S HRAT HIALTeT - Heailed o=

TRME 1- AR HITETT HHAT 6T TIAH S5 el €5 |

3dc - 9 fGHAST 1946 |

TR 2- T aUTeT THT T TATS 37EJET ot 2T |

3dcK - 1. oielg 991G |

TR 3- TG THT T ITATS ITIET et T |

3dcK - 31. Afcaeree g |

G2AA 4- HIAYUTA FHT b U169 FIATA & 31¢8T i o |

3dcK - 1. HFRIG 3HEEH |

g2l 5- EigemeT HT T 3qaries & & gfdurge fhas fohar |
3dcR - TH. UA. 30 |

T2 6- IR H TITETT THT TS et T YR HAT AT |

3R - Shissie AT AT (1946) |

TRl 7- TITET & ST I ART GAYUH 1895 F fohd gTed of I |
3R - STl I9MER faere |

g2l 8- TigermeT T # 2t Raradr & fordel gfafafer & |
3dd% - 70 |

g2l 9- HiaeTs FHT # fora et Rarad & gfafafer o emer &3¢y foram |
3N - BeIETg |

SR 10- Y. 3. IHSSHT T & AUt HT 3 el gu |
3R - M H |




RIeT 11- HIAUTT FHT T At {oleh TeTghR bl fgenc fonar aram 2 |
3dcX - &l T, T |

TRIE 12- WAL T T I HATT T TS Hel §3 |

3R - 29 37T 1947 |

YRl 13- HigeTe &l I GfATT & GHET THATIAT T THATT Tohdel I&T |
3R - STATER ool g% |

UM 14- HIAUTeT FHT T TIAT g HITETeT b [ FATUH Fohsel JEcld R |
3R - FaxToT UTét of 1924 # |

RIS 15- HIGETT HHT H IR & HIAUT T hel Fellehd fohT |

3dcR - 26 FATHSR 1946 |

T2l 16- TIGETT Sl Tallel H Tohclall THT 4T |

3R - 2dY 11 ATg 18 &7 |

g2l 17- T 7 frae srgaoe

3R - 444 |

TRIeT 18- AT & fohclel 3T &
3daT - 22 |

RIST 19- ST THT 3 fehctell 3feeferdr &
3daT- 12 |
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3K - FIT AAITERR | |
3T e & T I Hbr T ol a Tgan

1. (a+B)*= a?+2aB+B?

2. (a+B)?*= (0-B)*+40B

3. (0-B)?*= a?-20B+B?

4. (0-B)*= (a+B)*-40B

5. a® + B?= (a+B)? - 2aB.

6. o? + B%>= (0-B)? + 20B.

7. 0%-8?=(a + B)(a - B)

8. 2(a* + B?) = (0+ B)* + (0 - B)?

9. 4aB = (a + B)? -(a-B)?

10. aB ={(a+B)/2}*-{(a-B)/2}*

1. (a+B+ ¢)P=0%+B2+¢2+ 2(0B + B¢ + ¢Q)
12. (a + B)* = a® + 30%B + 3aB? + B®
13. (a +B)*=0®+B%+ 30B(0 + B)
14. (0-B)*=a*-30%8+30B%-B°

15. a®* + B®* = (0 + B) (0* -aB + B?)
16. a® + B® = (0+ B)® -30B(0+ B)



17. a® -8 = (a -B) (0% + 0B + B?)
18. a® -B® = (a-B)*® + 30B(0-B)
sin0° =0

sin30° = 1/2

siN45° = 142

sIN60° = V3/2

sin90° =

¢0s IS oppOsITE Of sIn
Tan0° =0

Tan30° = 143

Tan45° = 1

TON60° = V3

TaN90° = o

¢OT IS OpposITE Gf TaN
se¢0° =1

se¢30° = 2/7/3

se¢45° =2

se¢60° = 2

se¢90° = «

¢oseg¢ Is opposITe Of se¢
2sina¢osB=sin(a+B)+sin(a-B)
2¢osasine=sin(a+e)-sin(a-B)
2¢osa¢osB=¢os(a+B)+¢os(a-B)
2sinasinB=¢os(a-B)-¢os(a+s)
sin(a+B)=sina ¢osB+ ¢osa sinB..

» ¢0s(a+B)=¢0sa ¢OSB - SINaA SINB.

» sIn(a-B)=sINa¢osB-¢0osasInB.
» ¢os(a-B)=¢0osa¢asB+sinasinBg.

» Tan(a+s)= (Tana + Tans)/ (1-Tanarans)

» Tan(a-B)= (Tana — Tane) / (1+ Tanarans)
» ¢oT(a+B)= (¢oTa¢oTts -1) / (¢oTa + ¢OTB)
» ¢oT(a-B)= (¢oTa¢oTtB + 1)/ (¢0TB— ¢OTQ)

» sin(a+B)=sina ¢osB+ ¢osa sinB.

» ¢os(a+B)=¢osa ¢oSB +sINa SINB.

» sin(a-B)=sINa¢osB-¢osasinBg.
» ¢os(a-B)=¢0osa¢asB+sinasinBg.

» Tan(a+s)= (Tana + Tans)/ (1-Tanarans)

» Tan(a-B)= (Tana — Tans) / (1+ Tanartans)
» ¢oT(a+B)= (¢oTa¢oTts -1) / (¢oTa + ¢OTB)
» ¢oT(a-B)= (¢oTa¢goTB + 1)/ (¢0TB— ¢OTQ)

a/sina = B/siNB = ¢/sin¢ = 29
» 0 =B ¢0S¢ + ¢ ¢OSB

» B =0 ¢os¢ + ¢ ¢osa

» ¢ =a ¢osB + B ¢osa

» ¢osa = (B2 + ¢>- a?) / 2B¢
» ¢osB = (¢2 + a*- B?) / 2¢a



» ¢os¢ = (a® + B®- ¢?)/ 2¢a

» A = aB¢/4a

» sIN® = 0 THeNn,O© = nll

» sIN® =1 THeN,© = (4n + 1)N/2

» sIN® =—1 THeN,0 = (4n— 1)I1/2

» sSIN® = sina THen,® =Nl (-1)*na

1. sin2a = 2sina¢osa

2. ¢os2a = ¢os?a - sin?a

3. ¢os2a = 2¢os?a - 1

4. ¢0s2a =1 - sin%a

5. 2sin*a = 1 - ¢os2a

6. 1 + sin2a = (sina + ¢osa)?
7.1 - sin2a = (sina — ¢osa)?
8. Tan2a = 2tana / (1 - Tan?a)
9. sin2a = 2tana / (1 + Tan?a)
10. ¢os2a = (1 — Tan?a) / (1 + Tan?a)
11. 4sina = 3sina - sin3a

12. 4¢osa = 3¢osa + ¢os3a

» SIN*@+¢o0s?0=1

» se¢?0-Tan?0=1

» ¢0se¢?0O-¢oT?0=1
» siN®=1/¢ose¢O

» ¢ose¢O@=1/sin@

» ¢0sO=1/se¢®

» se¢O=1/¢osO

» Tan®=1/¢oT1®

» ¢oTO=1/TaN®

» TaN®=sIN®/¢osO

N

9th,10th,11th,12th, 70T fawr o TR Brefel &..
LT Hieh H3f sl & parents @I SR share Y 3R sl I @ #F Fg |

edic,
HTfil'é:I"rslgd HEcaqUT SR %mmgmwwmmwﬁ

» B. A. — Bachelor of Arts.

» M. A. — Master of Arts. »B.tech - Bachelor of Technology
» B. Sc. — Bachelor of Science

» M. Sc. — Master of Science

» B. Sc. Ag. — Bachelor of Science in Agriculture

» M. Sc. Ag. — Master of Science in Agriculture




» M. B. B. S. — Bachelor of Medicine and Bachelor of Surgery
» B.A.M.S- Bachelor of Ayurved Medicine and surgery
» M. D. — Doctor of Medicine

» M. S. — Master of Surgery

» Ph. D. / D. Phil. — Doctor of Philosophy (Arts & Science)
» D. Litt./Lit. — Doctor of Literature / Doctor of Letters
» D. Sc. — Doctor of Science

» B. Com. — Bachelor of Commerce

» M. Com. — Master of Commerce

» Dr. — Doctor

» B. P. — Blood Pressure

» Mr. — Mister

» Mrs. — Mistress

» M.S. — miss (used for female married & unmarried)
» Miss — used before unmarried girls)

» M. P. — Member of Parliament

» M. L. A. — Member of Legislative Assembly

» M. L. C. — Member of Legislative Council

» P. M. — Prime Minister

» C. M. — Chief Minister

» C-in-C — Commander-In-Chief

» L. D. C. — Lower Division Clerk

» U. D. C. — Upper Division Clerk

» Lt. Gov. — Lieutenant Governor

» D. M. — District Magistrate

» V. I. P. — Very Important Person

»|. T. O. — Income Tax Officer

» C. |. D. — Criminal Investigation Department

» C/o — Care of

» S/o — Son of

» C. B. I. — Central Bureau of Investigation

» G. P. O. — General Post Office

» H. Q. — Head Quarters

» E. O. E. — Errors and Omissions Excepted

» Kg. — Kilogram

» KW. — Kilowatts

Gm. — Gram

Km. — Kilometer

Ltd. — Limited

M. P. H. — Miles Per Hour

KM. P. H. — Kilometre Per Hour

P.T. O. — Please Turn Over

P. W. D. — Public Works Department

C. P. W. D. — Central Public Works Department

U. S. A. — United States of America

U. K. — United Kingdom (England)



U. P. — Uttar Pradesh

M. P. — Madhya Pradesh

H. P. — Himachal Pradesh

U. N. O. — United Nations Organization

W. H. O. — World Health Organization

B. B. C. — British Broadcasting Corporation
B. C. — Before Christ

A. C. — Air Conditioned

I. G. — Inspector General (of Police)

D. I. G. — Deputy Inspector General (of Police)
S. S. P. — Senior Superintendent of Police
D. S. P. — Deputy Superintendent of Police
S. D. M. — Sub-Divisional Magistrate

S. M. — Station Master

A. S. M. — Assistant Station Master

V. C. — Vice-Chancellor

A. G. — Accountant General

C. R. — Confidential Report

I. A. S. — Indian Administrative Service

I. P. S. — Indian Police Service

l. F. S. — Indian Foreign Service or Indian Forest Service
I. R. S. — Indian Revenue Service

P. C. S. — Provincial Civil Service

M. E. S. — Military Engineering Service

Full Form Of Some technical Words
» VIRUS - Vital Information Resource Under Seized.
» 3G -3rd Generation.
» GSM - Global System for Mobile Communication.
» CDMA - Code Division Multiple Access.
» UMTS - Universal Mobile Telecommunication System.
» SIM - Subscriber Identity Module .
» AVI = Audio Video Interleave
» RTS = Real Time Streaming
» SIS = Symbian
OS Installer File
» AMR = Adaptive Multi-Rate Codec
» JAD = Java Application Descriptor
» JAR = Java Archive
» JAD = Java Application Descriptor
» 3GPP = 3rd Generation Partnership Project
» 3GP = 3rd Generation Project
» MP3 = MPEG player-3
» MP4 = MPEG-4 video file
» AAC = Advanced Audio Coding



» GIF= Graphic Interchangeable Format

» JPEG = Joint Photographic Expert Group
» BMP = Bitmap

» SWF = Shock Wave Flash

» WMV = Windows Media Video

» WMA = Windows Media Audio

» WAV = Waveform Audio

» PNG = Portable Network Graphics

» DOC =Document (Microsoft Corporation)

» PDF = Portable Document Format

» M3G = Mobile 3D Graphics

» M4A = MPEG-4 Audio File

» NTH = Nokia Theme (series 40)

» THM = Themes (Sony Ericsson)

» MMF =Synthetic Music Mobile Application File
» NRT = Nokia Ringtone

» XMF = Extensible Music File

» WBMP = Wireless Bitmap Image

» DVX = DivX Video

» HTML = Hyper Text Markup Language

» WML =Wireless Markup Language

» CD -Compact Disk.

» DVD - Digital Versatile Disk.

» CRT - Cathode Ray Tube.

» DAT - Digital Audio Tape.

» DOS - Disk Operating System.

» GUI -Graphical

User Interface.

» HTTP - Hyper Text Transfer Protocol.

» |IP - Internet Protocol.

» ISP - Internet Service Provider.

» TCP - Transmission Control Protocol.

» UPS - Uninterruptible Power Supply.

» HSDPA -High Speed Downlink Packet Access.
» EDGE - Enhanced Data Rate for Evolution.
» GSM- [Global System for Mobile Communication]
» VHF - Very High Frequency.

» UHF - Ultra HighFrequency.

» GPRS - General Packet Radio Service.

» WAP - Wireless Application Protocol.

» TCP - Transmission Control Protocol.

» ARPANET - Advanced Research Project Agency Network.
» IBM - International Business Machines.

» HP - Hewlett Packard.

» AM/FM - Amplitude/ Frequency Modulation



